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. . .72 4 Back to TOC Back to TOC Getting started 5 1 Getting started This section contains the basics to help you get started with your new HP ScanJet
scanner. From here, you can learn about viewing the product tour, preparing items before you scan them, and choosing which scanning method to use.

Viewing the product tour The product tour is a fast and easy way to explore the capabilities of the scanner and see some interesting ways you can use the
scanner to meet your needs. The product tour, which only takes three minutes, begins automatically when you start the HP PrecisionScan Pro software for the
first time. To view the tour at other times: In the HP Scanning Software folder, double-click Product Tour. Printing this information You can print this PDF
manual using the Print command on the File menu. Print the whole document, or print only the chapters or topics you want according to their page numbers.
See the table of contents for page numbers of topics. 6 Getting started Back to TOC Where do I start? You can start scanning from one of these places: q q q q
Using another program Start scanning from within another program when: q the scanner buttons the HP PrecisionScan Pro software another program the
HP ScanJet Copy Utility q You want to bring a scanned item into an open program, such as your word-processing program. The program in which you are
working is compliant with TWAIN or the HP ScanJet Plug-in (which is an Adobe® Photoshop® plug-in). A program is compliant if a command like Acquire
Image or From Scanner appears on a menu such as the File menu. If you are unsure whether your program complies with TWAIN standards or supports
Photoshop plug-ins--or you do not know the command for inserting a scanned item, see the documentation for the program.
Where you start depends on what you want to do with the scan and on your own preferences. Using the scanner buttons Use the scanner buttons, which are
shortcuts, when: q q q See "Scanning from other programs" on page 64. You want to start at the scanner. You want to scan quickly without making changes.
You want to scan an item using the default settings optimized for the destination you choose.
Using the HP ScanJet Copy Utility Start scanning from the HP ScanJet Copy Utility when you want to make copies and need to make standard copy
adjustments, such as reducing or enlarging or lightening or darkening. You can also choose a printer other than the default. To start the utility: in the HP
Scanning Software folder, double-click HP ScanJet Copy Utility. For help using the utility, move the pointer over the button or option to find more
information about the feature. See "Scanning from scanner buttons" on page 15. Using the HP PrecisionScan Pro software Use the HP PrecisionScan Pro
software when: q You want to view or change a scanned image before you send it. Changes might include resolution, cropping, or resizing. You want to send
to a destination, such as a desktop publishing program, but there is no button on the scanner for that destination. q See "Scanning from HP PrecisionScan
Pro" on page 29. Back to TOC Getting started 7 Selecting and preparing items Before placing items in the scanner, follow these guidelines for selecting and
preparing them to prevent damage to the items and the scanner.
Items for the ADF The HP ScanJet automatic document feeder (ADF), which is a fast, convenient way to scan multiple-page items, is included with some
scanner models, or it can be ordered. The ADF accepts items that meet the following specifications: q Items on standard Letter-, A4-, and Legal-size paper
Items consisting of up to 50 unbound pages Items ranging in size from 148.5 by 210 mm (5.8 by 8.3 inches) to 215.9 by 355.6 mm (8.5 by 14 inches) Items
ranging in weight from 60 to 105 g/m2 (16 to 28 lb) Items that are square or rectangular and in good condition (not fragile or worn) Items that are free of
tears, perforations, or punch holes Items that are free of wet glue, correction fluid, and ink Items for the scanner glass The scanner glass can scan the widest
range of items, including: q q q q q Paper items News clippings, receipts, and business cards Items on all weights of media, including media lighter than 60
g/m2 (16 lb) or heavier than 105 g/m2 (28 lb) Gum-backed paper Multipart forms with carbon pages Old or worn photographs or documents Items containing
tears, perforations, punch holes, wrinkles, or curls Flatter, three-dimensional items such as pages in books, fabric, and paper with texture CAUTION Avoid
placing items with sharp edges in the scanner.
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Doing so can damage the scanner. q q q q q q q q q Avoid multipart forms with carbon pages, transparencies, magazine pages, gum-backed pages, and light
"onionskin" pages.
Before placing an item in the ADF, prepare the item by doing the following: q q Remove curls or wrinkles. Remove staples, paper clips, paper sticky notes,
and any other materials from items. Before placing an item on the scanner glass, make sure the item is free of wet glue, correction fluid, or other
contaminating substances. If your item does not meet these guidelines or you cannot prepare it as stated, use the scanner glass. 8 Getting started Back to TOC
Items for the XPA The HP ScanJet transparency adapter (XPA) is included with some scanner models or can be ordered.
Use the XPA and its templates to scan: q q q photographic negatives 35 mm slides other transparent media up to 127 to 127 mm (5 by 5 inches) in size. For
transparent items larger than these measurements, scan without using the XPA. Just cover the item with a piece of white paper and scan as you normally
would. Because these items are easily damaged, handle them only by their edges. Back to TOC Getting started To load the item in the scanner 1 Choose an
item to scan, such as a page from a magazine.
9 Completing your first scan Doing your first scan is easy. This section shows you how to take the same item and scan to print using the two primary scanning
methods: q q the scanner buttons HP PrecisionScan Pro software Before scanning, you will load the item in the scanner. 2 Place the item face down on the
scanner glass and close the lid. 3 See "To complete your first scan using the scanner buttons" on page 10. 10 Getting started 4 Back to TOC On the scanner,
press COPY. The scanner scans the item using settings optimized for printing this type of item and then prints the item to the default printer. To complete your
first scan using the scanner buttons 1 2 Load the item in the scanner. See "To load the item in the scanner" on page 9. Select COLOR COPY or B&W COPY
by pressing the button until the light next to your choice is lit. Only select COLOR COPY if you are printing to a color printer.
Copy button Color or B&W button If you have not already scanned using the HP PrecisionScan Pro software, see "To complete your first scan using the HP
PrecisionScan Pro software" on page 11. 3 To make more than one copy, press NUMBER OF COPIES until the number you want appears on the display.
Number of copies button Back to TOC To complete your first scan using the HP PrecisionScan Pro software 1 2 Load the item in the scanner. See "To load
the item in the scanner" on page 9. With the item loaded, press HP SCANNING SOFTWARE on the scanner. The scanner scans the item to the HP
PrecisionScan Pro software, choosing the best settings for this type of item. When the scanned image appears in the preview window of the software, draw a
selection border around the image or portion of the image you want. To do so, click on one corner of the area you want, and while holding down the mouse
button, drag the cursor to the opposite corner. Release the mouse button to complete the border. 4 5 6 Getting started 11 Experiment with the image.
Change the output type or make other adjustments. When you finish: On the Scan menu, click Print. Select any printer options you want and click OK. The
scanner performs a final scan including your changes, and the scanned image prints. 3 If you have not already scanned using the scanner buttons, see "To
complete your first scan using the scanner buttons" e scanned images before they go to the destination or file.
To view or change images, use the HP SCANNING SOFTWARE button, which sends the scanned image to the HP PrecisionScan Pro software. See the next
chapter, "Scanning from HP PrecisionScan Pro." Tip You can change the default settings for buttons on the scanner. See "Changing settings for buttons" on
page 25. 16 Scanning from scanner buttons Back to TOC Overview of scanner buttons more options e-mail photo e-mail document E-mail Fax Copy File HP
Scanning Software number of copies color copy b&anto an e-mail message.
The scanner scans the item but then prompts you to save it as a file. After saving the image as a file, open an e-mail message and attach the file as you
normally do. To be prompted to save the file, make sure that E-mail file is selected in the button options. Otherwise, you receive an error message when you
press E-MAIL at the scanner. See "Changing settings for buttons" on page 25 to check or change which e-mail program is set as the default, or to set E-mail
file as the default. Back to TOC Scanning from scanner buttons To fax a scan from the scanner 1 19 Faxing a scan When you fax using the scanner buttons,
the scanner scans the item using default settings optimized for faxing. If you have a supported fax application program, the scanned image then automatically
appears in a new fax message, which you then address and send. You do not make changes to the scanned image. Place the original face down on the scanner
glass and close the lid. Tip If your fax program is not supported, select Fax anyway.
The computer scans the item using the optimal settings, and the computer prompts you to save the scanned image as a file. Open your fax program and attach
the file to a message as you normally do. Note: 2 3 To load items in the ADF, see page 66. Press FAX on the scanner. If the scanner or the computer prompts
you for another page, do one of the following: q q If you do not have more pages to scan, click Done. If there are additional pages of this item, load the next
page and click Scan. Repeat until all pages are scanned. Then, click Done. 4 If you have a supported fax program, the scanned image automatically appears
in a new fax message. Address the message and send it as you normally do.
If the scanned image does not attach to a new message, see "Supported fax programs" on this page. 20 Scanning from scanner buttons Back to TOC
Supported fax programs Supported fax programs allow the scanner to scan items directly into new fax messages. If a scanned image automatically appears in
a new fax message, your fax program is supported. If you are using an unsupported fax program, the scanner cannot scan items directly into a fax message.
The scanner scans the item but then prompts you to save the scanned image as a file.
After saving the image as a file, open a fax message and attach the file as you normally do. To be prompted to save the file, make sure that Image file is
selected in the button options. Otherwise, you receive an error message when you press FAX at the scanner. See "Changing settings for buttons" on page 25
to check or change which fax program is set as the default, or to set Image file as the default.
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Back to TOC Scanning from scanner buttons To print copies from the scanner 1 21 Printing copies You can scan an item and send it to a printer to make
copies using the scanner button.
At the computer, you can see the progress of the scan or you can cancel the scan. (If you cancel the scan, the printer might feed a blank page to the output
bin.) Note that when you make copies, each page is treated as a separate print job, so the printer does not collate copies. Place the original face down on the
scanner glass and close the lid. Note: 2 To load items in the ADF, see page 66. Select COLOR COPY or B&W COPY by pressing the button until the light
next to your choice is lit. Only select COLOR COPY if you are printing to a color printer and want a color copy. Select the NUMBER OF COPIES by pressing
the button until the number you want appears. Press COPY on the scanner. To reduce or enlarge the copies, lighten or darken them, or change which printer
prints them, press +.
(COMMAND KEY+PERIOD) on the computer to set options in the HP ScanJet Copy Utility. Change options and click Copy. If you do not click the
COMMAND KEY+PERIOD, the number of copies specified on the scanner print directly to the default printer. Note: If you cancel the scan, the printer might
feed a blank page to the output bin. 3 4 5 22 Scanning from scanner buttons To save a scan to a file from the scanner 1 Back to TOC Saving a scan to a file
You can scan and save items directly to files for archiving purposes without making changes to them. The files are saved in PDF format, which keeps the
original page formatting. Place the original face down on the scanner glass and close the lid. Tip To save a scanned image in a different file format, scan to
the HP PrecisionScan Pro software, and on the Scan menu, click Save As. Note: 2 3 4 To load items in the ADF, see page 66. Press FILE on the scanner.
In the Save As dialog box, name the file, choose a location in which to save it, and click Save. If the scanner or the computer prompts you for another page, do
one of the following: q q If you do not have more pages to scan, click Done. If there are additional pages of this item, load the next page and click Scan.
Repeat until all pages are scanned. Then, click Done.
Back to TOC Scanning from scanner buttons To make text editable from the scanner 1 23 Making scanned text editable You can make text on a scanned image
editable. The optical character recognition (OCR) program converts the text to be editable and then places it in a supported word-processing program.
Depending on the capabilities of the word-processing program, graphics on a scanned image might be retained or discarded, or the OCR program might try
to convert them and they will appear as random characters. Place the original face down on the scanner glass and close the lid. Tip If a block of text appears
in Microsoft Word or another word-processing program inside a frame you do not want, double-click the frame border and click Remove Frame or a similar
command.
Note: 2 3 To load items in the ADF, see page 66. Press EDIT TEXT on the scanner. If the scanner or the computer prompts you for another page, do one of
the following: q q If you do not have more pages to scan, click Done. If there are additional pages of this item, load the next page and click Scan. Repeat until
all pages are scanned. Then, click Done. 4 When the text opens in the word-processing program, check it carefully for accuracy. 24 Scanning from scanner
buttons Supported word-processing programs Back to TOC What to expect from OCR programs Optical character recognition programs convert some text
more accurately than other text. Because OCR technology is never perfect, proofread all converted text carefully to ensure the characters have been correctly
interpreted. These types of text convert most accurately: q q q q By default, text converted using the OCR program appears in Microsoft Word or SimpleText.
By changing the settings for the EDIT TEXT button, you can have text appear in a different, supported program instead. See "Changing settings for buttons"
on page 25. The Edit Text tab on the Buttons tab of the HP ScanJet Controls dialog box will display the supported programs installed on the computer. text in
standard fonts text in 9-point font or larger crisp, clear text black text on a white background These types of text might convert less accurately: q q q text close
to non-text elements, such as bullets, lines, or graphics text in spreadsheets, tables, or forms letters that have gaps, that "bleed" along their edges, or that
touch other letters underlined text text on colored paper q q Handwriting cannot be converted. Back to TOC Scanning from scanner buttons 25 Changing
settings for buttons When you use the scanner buttons, the scanner scans the item using settings optimized for the destination, such as e-mail, that is
associated with that button. Settings are applied to all items being scanned until you change the settings again. List of options for scanner buttons With the
HP ScanJet Controls control panel, you can select scanning options that are applied to items you scan using the following scanner buttons: q q q E-MAIL
(with the E-MAIL PHOTO button) E-MAIL (with the E-MAIL DOCUMENT button) FAX COPY FILE HP SCANNING SOFTWARE EDIT TEXT Tip To
change the settings only for the current item, you may want to scan using the HP PrecisionScan Pro software instead. See Scanning from HP PrecisionScan
Pro (starting on page 29). q q q q To change settings for buttons 1 Do one of the following: q q The following scanning options are available on the Buttons
tab. q q Destinations options.
See "Destinations options" on page 26. Image Output options. See "Image options" on page 26. ADF Page Size options. See "ADF Page Size options" on page
27.
On the scanner, press MORE OPTIONS (if present). Choose Control Panels from the Apple ( ) menu, and then choose HP ScanJet Controls from the
submenu. q 2 On the Buttons tab, click the tab for the button you want. The boxes in the middle of the tab contain the settings that can be changed. Change the
setting for the button.
See "List of options for scanner buttons" on page 25 for more information. Repeat step 3 to change any other settings for this button. Repeat steps 2 through 4
to change settings for another button. When finished, click the close box. 3 4 5 6 26 Scanning from scanner buttons Image options Resolution Back to TOC
Destinations options Destinations The Destinations pull-down menu lists the available destinations on your computer. Note: Type of file When Image is
selected, the scanned image is saved as an image file. If the scanned image contains text, this text is not editable. When Text is selected, output is converted to
one column in what the software perceives to be the most logical order.
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Graphics or pictures from the scanned item are discarded. Use this option to make more extensive changes to text.
When Image and Text is selected, output is converted to a format that creates editable text. Any graphics or pictures in the scanned item are preserved.
Prompt for Another Page When this option is selected, a prompt appears on the computer after you scan the first page of a job. The prompt asks if you have
more pages to scan to this job. When this option is not selected, you will not be prompted for more pages. Each scanning job will be treated as a single-page
job. If a destination does not support an option on the Buttons tab, the option is dimmed. Select a resolution from the pull-down menu, or type a resolution in
the text box. Output Type From the Type pull-down menu, select one of the options below: q True Color creates an image that is rendered with 24-bits per
pixel per color. 256 Color Palette creates an image that contains the 240 most common colors in the image, plus the 16 basic colors.
Grayscale creates an image containing shades of gray, not just black and white. In a grayscale image, each pixel contains multiple bits of information,
allowing more shades of gray to be recorded and displayed. Black & White creates an image that contains only black pixels and white pixels, no colors or
shades of gray. Each pixel represents one bit. q q q For more information about using these options, see "List of file types" on page 52.
Automatic Cropping When this option is selected, the scanner includes only the item or items on the scanner glass in the resulting scanned image. When this
option is not selected, the scanner includes the entire area of the scanner glass, including blank areas, in the resulting scanned image. Back to TOC ADF
Page Size options If you are using an ADF with the scanner, select the size of the pages you load in the ADF: q q q Scanning from scanner buttons 27 Letter
Legal A4 For more information about loading items in the ADF, see "Scanning from the ADF" on page 66. 28 Scanning from scanner buttons Back to TOC
Back to TOC 29 3 Scanning from HP PrecisionScan Pro Using the HP PrecisionScan Pro software, you can preview scanned images and make changes to the
images before you send them to a destination or file them. You start the HP PrecisionScan Pro software from a scanner button or the HP Scanning Software
folder on your computer.
You can also start the HP PrecisionScan Pro software from another program, such as a word-processing or image-editing program, if the program is
compliant with TWAIN or supports the HP ScanJet Plug-in. See "Scanning from other programs" on page 64 for more information. Overview of the HP
PrecisionScan Pro software The HP PrecisionScan Pro software provides preview capabilities and tools for changing an image. Some of the changes you can
make include: q select only part of, or crop, the preview image to become the final scanned image change the resolution resize the scanned image change the
contrast q q q 30 Scanning from HP PrecisionScan Pro Back to TOC To start the software without initiating a scan In the HP Scanning Software folder,
double-click HP PrecisionScan Pro. The software starts. Hover over a command in this toolbar to see an explanation Finding help for using the software The
HP PrecisionScan Pro software provides several means of assisting you. Smart Friends Smart Friends are tips that appear automatically to notify you of
potential problems. For example, if you are setting a very high resolution but want to e-mail the scanned image, a Smart Friend would alert you that the file
will probably be too large to e-mail. To turn individual messages off, select the Don't remind me again check box in the message's dialog box. To turn all
messages off, click Disable All Smart Friends on the Help menu.
To turn all messages back on, click Enable All Smart Friends. Online Help For more information about the types of assistance the software itself offers, see
"Finding help for using the software" on this page. For more information about keyboard shortcuts, menu items, toolbars, and cursor appearance, see "Using
software commands and controls" on page 101. The online Help is an easy-to-use source of information about using the scanner and software,
troubleshooting, support, and specifications. To gain access to the Help: on the Help menu, click HP PrecisionScan Pro Help. Or, click the Help button in any
dialog box in which it appears. Back to TOC Scanning from HP PrecisionScan Pro 2 Start the scan in one of these ways: q q q 31 Performing a new scan
Once you start a new scan, the scanner does a preliminary scan of the item and displays the scanned image in the HP PrecisionScan Pro software. Then, you
can see the scanned image and edit it, if necessary, before sending it to a destination or saving it as a file. On the scanner, press HP SCANNING SOFTWARE.
In the HP PrecisionScan Pro software, click on the toolbar.
In the HP PrecisionScan Pro software, click New Scan on the Scan menu. To start (preview) a new scan 1 Place the original face down on the scanner glass
and close the lid. The scanned image appears in the HP PrecisionScan Pro software. This scanned image is the preview image. You can make changes, such
as selecting only part of the image or adjusting the contrast.
When you send the image to another program such as e-mail, place the image on a website, or save it as a file, the scanner performs a final scan of the item
that includes any changes you made. Directions for making optional adjustments and completing the scan appear in this section. Note: To load items in the
ADF, see page 66. 32 Scanning from HP PrecisionScan Pro To crop or select an area for final scan Do one of the following: q q Back to TOC Cropping or
selecting an area for final scan Once a scanned image appears in the HP PrecisionScan Pro software, you must select which area becomes the final scanned
image by creating a selection area. When you create a selection area, a dotted selection border appears around the area: q Move the cursor over the area you
want and click.
When the cursor looks like this: , click on one corner of the area you want and drag the cursor to the opposite corner to draw a rectangular selection area. On
the Edit menu, click Select All. The entire scanner bed, including blank areas, is selected. To resize the selection area selection border Click the edge of the
selection border and drag to resize. To move the selection border Move the cursor over the selection area. When the cursor looks like this: , click and drag the
selection border to the new location. To remove the selection border Do one of the following: q q Press ESC. On the Edit menu, click Unselect All. Draw a
selection border around a different area of the image. For information about the appearance of the cursor when it is over an area of the selection border, see
"Context-sensitive cursors" on page 107.
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q Tip If you only want to look more closely at an area without changing what will be included in the final scan, see "Getting a closer look (zooming)" on
page 33. Back to TOC Scanning from HP PrecisionScan Pro 33 Getting a closer look (zooming) Zoom in on the selection area to look at it more closely or
make changes to it. Zoom out to view the entire preview image, or so you can select a different area of the image to view. Zooming in on the selection area
before making changes or performing a final scan provides the best final results. The zoom commands are not available if you have not created a selection
area. Zooming in and out does not change which part of the image becomes the final scan, nor does it change the final output size (physical output
dimensions). To change which part of the image becomes the final scanned image, see "Cropping or selecting an area for final scan" on page 32. To resize
the image, see "Resizing (output dimensions)" on page 35. Selecting output type When Automatically Set Type is selected, the scanning software automatically
chooses an output type based on the type of item you are scanning. However, you can change the output type yourself when you want.
Choose the output type based on how you will use the final scanned image as well as the type of item you are scanning. To select an output type 1 Do one of
the following: q q To zoom in After creating a selection area, do one of the following: q q On the View menu, click Zoom in. Click . q To zoom out Do one of
the following: q If it is not already selected, click Automatically Set Type on the Output Type menu, to allow the software to choose the best output type for
this type of original item. To change the output type only for this scan, keep Automatically Set Type selected and select an output type you want from the
Output Type menu.
See "List of output types" on page 34. To change the output type for this scan and all other scans in this session, clear Automatically Set Type and select an
output type you want from the Output Type menu. See "List of output types" on page 34. Tip When you redraw the selection border, the output type might
change if Automatically Set Type is selected in the HP PrecisionScan Pro Preferences dialog box. On the View menu, click Zoom out to return to the original
view of the image.
Click . q 34 Scanning from HP PrecisionScan Pro To reset output type Use this output type True Color Back to TOC List of output types For these uses On the
Output Type menu, click Automatically Set Type. The software chooses the best output type based on the image inside the selection area. Color photos or
drawings with lots of shading to be: q printed on a color printer q displayed on a color monitor set to millions of colors q displayed on Web and saved in the
JPEG or PNG file format Color photos or drawings with shading to be: printed to a color printer sent via e-mail used in any way that requires a small file
size viewed on a computer screen Color photos or drawings with shading to be: printed to a color printer displayed on a monitor set to 256 colors displayed
on Web and saved as a GIF file Color photos or drawings with shading to be printed to a B&W printer. B&W photos and drawings with shading to be used
for any purpose. B&W drawings without shading to be placed in another program without resizing in the other program. Any image to be saved in GIF file
format and displayed on the Web. Color drawings or logos without much shading and with a concentrated area of a single color. The image is to be used for
any purpose. Optimized Palette q q q q System Palette q q q Grayscale Grayscale Black & White Bitmap Web Palette Spot Color Back to TOC Scanning from
HP PrecisionScan Pro 35 Making optional adjustments, basic These tools are needed most often, but using any of them is still optional.
Depending on the output type chosen, some tools will not be available. Resizing (output dimensions) You can resize the image before you do the final scan by
changing the output dimensions. Resizing the scanned image to the actual dimensions you need before performing the final scan helps ensure the best image
quality. Tip If you need to resize images to fit in a file, such as wordprocessing document, resize them here in the scanning software. Resizing images in the
other program may cause them to be fuzzy or have jagged edges. To resize an image 1 2 On the Tools menu, click Resize. The Resize dialog box opens. Do
one of the following: q q If necessary, select a unit of measure in the Units field. In the Output Dimensions area, type a new value in the Width or Height field
and press ENTER. In the Scale field, select a scale percentage.
New values appear in the Scale, Width, and Height fields, but the selection area and the scanned image on screen remain the same. Resizing occurs when you
complete the scan. 3 If you want, click . This locks the output dimensions you defined so you can change the selection area without changing the output
dimensions. When you change the selection border, the software resizes the border proportionally.
The output dimensions remain the same. 36 Scanning from HP PrecisionScan Pro Back to TOC Changing resolution Resolution determines the amount of
data in a scanned image. The scanning software chooses the optimal resolution based on the output type. This resolution generally does not need to change. If
you do change the resolution, choose one no higher than the capabilities of the monitor or printer and one appropriate for the type of scanned image.
For example, to print on a 600 dpi printer, choose 600 for black-and-white bitmap images, but choose only 200 for color or grayscale images. These
resolutions produce optimal quality while keeping file sizes small. Selecting higher resolutions for color images increases file size while not increasing
quality. If you double the resolution, the file size quadruples. Large file sizes can prevent you from doing certain tasks, such as e-mailing, or can take up too
much space on your computer. For help choosing a resolution based on the type of original item and destination, see "Tips for best image quality" on page
59. Changing contrast The contrast is controlled by the midtone, highlight, and shadow settings. See "Changing midtones" on page 40, "Changing highlights"
on page 41, and "Changing shadow" on page 42. To change resolution 1 2 On the Tools menu, click Change Resolution. Do one of the following: q q Select a
value from the list.
Type a value between 12 and 999,999 in the field and press ENTER. The resolution changes as soon as you select a value. To reset resolution On the Tools
menu, click Change Resolution. Then, click . Back to TOC Scanning from HP PrecisionScan Pro 37 Rotating an image You can rotate the image in 90-degree
increments clockwise or counterclockwise.
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You might need to rotate the image if you placed the bottom of the item at the top of the scanner glass, or if the item was sideways. Items such as negatives in
their template often scan sideways. Mirroring (reversing) an image You can mirror, or reverse, an image from side to side on the vertical axis. Mirroring an
image allows you to see the elements of the image on the opposite side of their actual position. Mirroring can be particularly useful for items such as
negatives that might be placed in their template backward and scanned in reverse.
To rotate an image Do one of the following: q To rotate an image clockwise: On the Tools menu, click Rotate right 90°. Or, click on the toolbar. Repeat to
continue turning. To rotate an image counterclockwise: On the Tools menu, click Rotate left 90°. Or, click on the toolbar.
Repeat to continue turning. q To mirror (reverse) an image On the Tools menu, click Mirror. Repeat to return to the original layout. 38 Scanning from HP
PrecisionScan Pro Back to TOC Sharpening an image Increasing sharpening enhances detail in the image. The HP PrecisionScan Pro software automatically
selects the optimal sharpen level, but you can change it.
You might want to increase sharpening if the image looks fuzzy. Conversely, you might want to decrease sharpening if the original item has flaws or marks on
it. Increasing sharpening, or increasing it too much, can accent the flaws and create undesirable patterns. Resetting all adjustments You can reset images to
the optimal (default) values the scanning software chose for the image. Optimal values are based on the output type selected. Resetting removes all
adjustments you have made except the output type, zoom level, or the selection area. To reset all adjustments Do one of the following: q q To sharpen an
image 1 2 On the Tools menu, click Sharpen. Select a sharpen level from the list. The viewer shows the effect of the changes on the image. On the Edit menu,
click Undo Editing Changes.
On the toolbar, click . To reset sharpen levels 1 2 On the Tools menu, click Sharpen. Click . Back to TOC Scanning from HP PrecisionScan Pro 39 Making
optional adjustments, advanced These optional adjustments are ones that most people generally do not use or need, but some advanced users might want them
for special effects or other needs. Depending on the output type chosen, some tools are not available. Inverting the image Use the Invert command to convert
white areas of an image to black and black to white. For color images, a color is converted to its complementary color. Generally, this command is useful for
drawings and spot color images. To invert the image On the Advanced menu, click Invert Colors. Repeat to reverse the colors again.
40 Scanning from HP PrecisionScan Pro To lighten the image overall 1 2 On the Advanced menu, click Adjust Exposure. Do one of the following: q q q Back
to TOC Changing midtones The midtone setting lets you lighten or darken the middle values in an image. The range for the number in the Midtone field is 1.0
to 4.0.
Moving toward 1.0 darkens the image. Moving toward 4.0 lightens the image. To adjust midtones for slides, negatives, or other transparent items, use
"Adjusting midtones for transparent items" on page 73.
Drag the Midtone slider to the right. Type a higher number in the Midtone field and press ENTER. Click the Up arrow next to the Midtone field. To darken the
image overall Midtone set at 1.8 (the default) Midtone set at 3.0 1 2 On the Advanced menu, click Adjust Exposure. Do one of the following: q q q Drag the
Midtone slider to the left. Type a lower number in the Midtone field and press ENTER. Click the Down arrow next to the Midtone field. To return to the
default settings 1 2 On the Advanced menu, click Adjust Exposure.
Click Auto to return the midtone, highlight, and shadow to the default settings for this scanned image. Clicking Auto also returns output levels to the defaults.
See "Setting pixel output levels" on page 44. Tip If you are sharing the image with others who will be viewing it on a computer screen, the Midtone value 2.2
is recommended because it is a value appropriate for many different monitors. Back to TOC Scanning from HP PrecisionScan Pro To increase detail in
lighter areas 1 2 On the Advanced menu, click Adjust Exposure. Do one of the following: q q 41 Changing highlights The highlight is the value in the image
that is represented on the screen as white. All values lighter than the highlight also appear as white. The image has a default highlight setting. Selecting a
higher number makes more of the lighter values distinct, which increases detail in light areas.
Selecting a lower number makes fewer of the lighter values distinct, which reduces detail in the light areas. To adjust highlights for slides, negatives, or other
transparent items, use "Adjusting highlights for transparent items" on page 73. Drag the Highlight slider toward the right. Type a higher number in the
Highlights field and press ENTER. To reduce detail in lighter areas 1 2 On the Advanced menu, click Adjust Exposure.
Do one of the following: q q Drag the Highlight slider toward the left. Type a lower number in the Highlights field and press ENTER. Highlights set at 215
Highlights set at 122 To choose a value as the highlight value Click (white eyedropper). When the cursor changes to the eydropper, move it over the area you
want to be the highlight and click. To return to the default settings 1 2 On the Advanced menu, click Adjust Exposure.
Click Auto to return the midtone, highlight, and shadow to the default settings for this scanned image. Clicking Auto also returns output levels to the defaults.
See "Setting pixel output levels" on page 44. 42 Scanning from HP PrecisionScan Pro To increase detail in darker areas 1 2 On the Advanced menu, click
Adjust Exposure. Do one of the following: q q q Back to TOC Changing shadow The shadow is the value in the image that is represented on the screen as
black. All values darker than the shadow also appear as black. The image has a default shadows value. Selecting a higher number makes more of the darker
values distinct, which increases detail in dark areas. Selecting a lower number makes fewer of the darker values distinct, which reduces detail in the dark
areas. To adjust shadows for slides, negatives, or other transparent items, use "Adjusting shadows for transparent items" on page 74.
Drag the Shadow slider toward the left. Type a lower number in the Shadow field and press ENTER. Click (black eyedropper). When the cursor changes to
the eydropper, move it over the area you want to be the shadow and click. To reduce detail in darker areas 1 Shadow set at 10 Shadow set at 3 2 On the
Advanced menu, click Adjust Exposure. Do one of the following: q q Drag the Shadow slider toward the right. Type a higher number in the Shadow field and
press ENTER.
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To select a value as the shadow value Click (black eyedropper). When the cursor changes to the eydropper, move it over the area you want to be the shadow
and click. To return to the default settings 1 2 On the Advanced menu, click Adjust Exposure.
Click Auto to return the midtone, highlight, and shadow to the default settings for this scanned image. Clicking Auto also returns output levels to the defaults.
See "Setting pixel output levels" on page 44. Back to TOC Scanning from HP PrecisionScan Pro To view and change clipped light (highlight) areas 1 2 3 On
the Advanced menu, click Adjust Exposure. 43 Checking for clipped areas The lightest or darkest areas of an image that will print without any detail in them
are known as clipped areas.
The lightest areas, or highlights, will print as the color of the paper (without ink or toner) and therefore will have no detail. The darkest areas, or shadows,
will print saturated in the blackest color of ink or toner, and therefore will also have no detail. You can view and change clipped areas if you want those areas
to contain detail when they print. Click (Highlight Alarm). The light areas in the image that will print as white (no detail) appear black.
In the Highlights setting, click the Up arrow repeatedly until the clipped pixels disappear from the image. The result of the change can be seen. Click again to
turn the Highlight Alarm off. 4 To view and change clipped dark (shadow) areas 1 2 3 On the Advanced menu, click Adjust Exposure. Click (Shadow Alarm).
The darker areas in the image that will print as black (without detail) appear white. In the Shadow setting, click the Down arrow repeatedly until the clipped
pixels disappear from the image. The result of the change can be seen. Click again to turn the Shadow Alarm off. 4 Normal view View when Highlight Alarm
selected View when Shadow Alarm selected 44 Scanning from HP PrecisionScan Pro To change output levels 1 2 3 On the Advanced menu, click Adjust
Exposure.
Back to TOC Setting pixel output levels The output levels setting lets you create interesting effects for scanned pictures. When you select this command, the
Black and White output levels appear. By default, white is set to 255, and black is set to 0. Decreasing the White output level makes the overall image darker.
Increasing the Black output level makes the image more faded. Changing the White output level value to 0 and the Black output level value to 255 inverts the
colors in the image. To change the ranges for the numbers in the White and Black fields, see the Controls tab of "Setting preferences" on page 60. Click the
Output Levels check box. The dialog box expands to display the current White and Black output levels. To change the levels, do one of the following: q q q
Click on the one side of a slider.
Type a different number in the White or Black field and press ENTER. Click the Up or Down arrow next to the White field or Black field. Tip To use an image
as a light background for dark text, such as for an overhead transparency, increase the Black output level until the image is as faint as you want. To use an
image as a dark background for light text, such as for color slides, decrease the White output level value until the image is as dark as you want. The result of
the changes to output levels can be seen in the preview area.
To return to the default settings 1 2 On the Advanced menu, click Adjust Exposure. Click Auto to return the midtone, highlight, shadow, and output levels to
the default settings for this scanned image. Back to TOC Scanning from HP PrecisionScan Pro 45 Viewing RGB values and pixels You can view the RGB
values and pixel color for any spot in a color or grayscale image using the RGB meter. To view the RGB values and pixel color for slides, negatives, or other
transparent items, use "Viewing RGB values and pixel color" on page 74. About the histogram The histogram is a graph of the distribution of pixels in the
selection area.
The magenta line represents the current setting for shadow. The red line represents the current setting for highlight. The midtone setting is not represented.
To view the RGB values and pixels 1 2 On the Advanced menu, click Adjust Exposure. Move the pointer over the image. The RGB values and pixel color
appear in the RGB meter. The turquoise line appears in the histogram when either eyedropper cursor is positioned over the image. This line shows you where
in the histogram the pixels in that area of the image occur. Shadow Highlight RGB values Pixel color Note: Do not click while the eyedropper pointer is over
the image unless you want to change the setting for highlight or shadow. Where pixels in the image under the eyedropper fall The histogram represents pixel
distribution in the preview image, not in the final scanned image.
Changing the selection area changes the histogram. Changing the setting for highlight or shadow does not change the histogram. 46 Scanning from HP
PrecisionScan Pro Back to TOC Changing the hue Color in an image consists of its hue and the saturation. Hue refers to the overall color cast of the image.
The software sets the hue for an image, but you can change it. You might want to change it if the image has too much of one color, or if you want to create a
special effect. Changing the saturation Color in an image consists of its hue and the saturation. Saturation refers to the intensity of the colors. The software
sets the saturation for an image, but you can change it. You might want to change it to make colors in the image more or less vivid, or to create a special
effect.
The range in the Saturation field is 0 to 150. To change the hue 1 On the Advanced menu, click Adjust Color. Indicator circle Arrows Change the overall
color of the image by doing one of the following on the color wheel. q To increase saturation 1 2 On the Advanced menu, click Adjust Color. Make colors
more vivid by doing one of the following: q q q q Drag the indicator circle to a new area.
Click the arrow for a color on the outer edge of the wheel. Click to the right of the slider. Type a higher number in the Saturation field and press ENTER.
Click the Up arrow next to the Saturation field. The result of the change can be seen in the image.
To decrease saturation 1 2 On the Advanced menu, click Adjust Color. Make colors less vivid by doing one of the following: q q q Tip If the image has too
much of one color, move toward the color's opposite. Click to the left of the slider. Type a lower number in the Saturation field and press ENTER. Click the
Down arrow next to the Saturation field. To return to the default settings 1 2 On the Advanced menu, click Adjust Color. Click Auto to return to the default
hue and saturation settings for this scanned image. To return to the default settings 1 2 On the Advanced menu, click Adjust Color. Click Auto to return to the
default hue and saturation settings for this scanned image.
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Back to TOC Scanning from HP PrecisionScan Pro To change black-and-white threshold 1 2 3 47 Changing the black-and-white threshold Changing blackand-white threshold only applies to images using the Black & White Bitmap output type.
The threshold is a value in the image that represents the border between black and white. All values in the image that are lighter than the threshold appear as
white, and all values darker appear as black. The image has a default threshold value. Choosing a number closer to zero makes more values appear as white.
Choosing a higher number makes more values appear as black. Make sure that Black & White Bitmap is selected on the Output Type menu. The selection
should have a dot beside it. On the Advanced menu, click Adjust Black & White Threshold. Do one of the following: q q q Drag the slider. Type a new value in
the field and press ENTER.
Click the Up or Down arrow next to the field. 4 If necessary, sharpen the image. This can be especially useful if the original was a color or black-and-white
photograph. See "Sharpening an image" on page 38. Threshold at 127 (the default for this image) To reset black-and-white threshold 1 2 On the Advanced
menu, click Adjust Black & White Threshold.
Click Auto. Threshold at 45 48 Scanning from HP PrecisionScan Pro Back to TOC To set which colors become black or white in black & white bitmaps 1 2 3
Make sure that Black & White Bitmap is selected on the Output Type menu. The selection should have a dot beside it. On the Advanced menu, click Adjust
Black & White Threshold. Select a color channel from the Scan using channel list.
q Setting which colors become black or white in black & white bitmaps This procedure only applies to color images that will be using the Black & White
Bitmap output type. It allows you to create special effects, or to correct for originals on colored paper. Images consist of pixels. In color images, each pixel
has a varying amount of Red, Green, or Blue to create its specific color. You can determine whether the Red, Green, or Blue in each pixel turns to black or
white in the final scanned image. q q q Choose Red to change the red in the image to white. Green and blue become black. Useful for originals printed on pink
or red paper. Choose Green to change the green in the image to white. Red and blue become black.
Useful for originals printed on green paper. Choose Blue to change the blue in the image to white. Red and green become black.Useful for originals printed
on blue paper. Choose NTSC Gray to convert light shades of all colors to white and dark shades of all colors to black. (No one color becomes all white or all
black.) Colors are converted to gray at a ratio of 30% red, 59% green, and 11% blue. To reset to the default colors 1 2 3 Make sure that Black & White
Bitmap is selected on the Output Type menu. The selection should have a checkmark beside it. On the Advanced menu, click Adjust Black & White Threshold.
Choose NTSC Gray from the Scan using channel list. Back to TOC Scanning from HP PrecisionScan Pro 49 Descreening images Use the Descreen command
to reduce undesirable patterns in printed items that you are scanning. An example of an undesirable pattern is a moiré pattern, or the circles that often appear
on pictures printed in newspapers. Note that scanning takes longer when this command is selected. If you are not scanning a printed original, turn Descreen
off to reduce scanning time.
Resetting all adjustments You can reset images to the optimal (default) values the scanning software chose for the image. Optimal values are based on the
output type selected. Resetting removes all adjustments you have made except the output type, zoom level, or the selection area. To reset all adjustments Do
one of the following: q q To descreen images On the Advanced menu, click Descreen. Select the option again to turn it off.
On the Edit menu, click Undo Editing Changes. On the toolbar, click . 50 Scanning from HP PrecisionScan Pro Back to TOC Completing the final scan When
you finish making changes, you need to complete the final scan by doing one of these tasks: q q Sending to a program Once you finish viewing and changing
the scanned image, you can perform a final scan and send it directly to a program such as e-mail. If the program you want is not available, save the image as
a file and insert it into the destination program as you normally would. To create editable text, you can send the scan to a text file and select a text or text-andimage file format. See "List of file types" on page 52. Sending to a program. See this page. Returning the image to a program that supports TWAIN or the HP
ScanJet Plug-in. See page 51.
Saving to a file. See page 52. Printing. See page 54. Placing a scan on a website. See page 55. Copying and pasting into another program. See page 57.
Dragging-and-dropping into another program. See page 57.
Dragging-and-dropping to the desktop or a folder. See page 58. q q q q q q Tip If you send text to Word or another word-processing program and the text
appears inside a frame you do not want, double-click the frame border and click Remove Frame or a similar command. To prevent this from happening in the
future, see "Setting preferences" on page 60. When you do any of these procedures, the scanner performs a final scan including your changes before sending
it to the program or printer you choose, copying the image, etc.
Images are not automatically saved as files if you print them, send them to a another program, or copy and paste them into a file in another program. To use
the scanned image again, be sure to save it. See "Saving to a file" on page 52. To send to a program 1 2 3 On the Scan menu, click Scan To. Choose a
program from the list and click Scan.
If the program you select accepts multipage files, you might be asked if you have more pages to scan to this file. Do one of the following: q q If this is a onepage item, click Done. If there are more pages of this item, load the next page in the scanner and click Scan on the computer. Repeat until all pages are
scanned. Then, click Done. The destination program opens and displays the scanned image. Back to TOC To create editable text 1 2 3 4 Choose Scan To from
the Scan menu. Choose Text File from the Destination pull-down menu, and then click Scan. Select a text or text-and-image file format in the Format pulldown menu, and then click Save. See "List of file types" on page 52.
If the program you select accepts multipage files, you might be asked if you have more pages to scan to this file. Do one of the following: q q Scanning from
HP PrecisionScan Pro 51 Returning the image to a program that supports TWAIN or the HP ScanJet Plug-in If you started the scan from a program that
supports TWAIN or the HP ScanJet Plug-in, you can perform a final scan and return the image to that program using this procedure.
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For more information about scanning using TWAIN or the HP ScanJet Plug-in, see "Scanning from other programs" on page 64. To return the image to a
program Do one of the following: q q If this is a one-page item, click Done. If there are more pages of this item, load the next page in the scanner and click
Scan on the computer. Repeat until all pages are scanned. Then, click Done. On the Scan menu, click Return Image To. On the toolbar, click . The OCR
program opens and creates editable text from the scanned image.
Note: You can also save a scanned image and import the image into your OCR software. See "To save a scan for future processing in OCR software" on page
52. 52 Scanning from HP PrecisionScan Pro List of file types Image file formats q Back to TOC Saving to a file Save scanned images as files when you want
to use the images again later. For help deciding on which file type to use, see "List of file types" on page 52, or see "Tips for best image quality" on page 59.
For definitions of File types, see the "Glossary" on page 109.
GIF. GIF is a compressed file format suitable for an image that will be used on the Web or on multiple platforms. Cannot be used with True Color output
type. JPEG. JPEG is a compressed file format for images.
Its strengths are small file sizes and speed. The trade-off for these advantages, though, is reduced image quality. Because each time an image is compressed
with JPEG it loses a little of the image data, avoid compressing a file with JPEG more than once. JPEG is an appropriate file format for an image that will be
used on the Web or on multiple platforms. You can save your JPEG file as a progressive JPEG. When used on a Web page, a progressive JPEG is initially
sent as just every other line, with the remaining lines sent immediately after. This allows a (somewhat blurry) image to display sooner. Most people prefer
this. JPEG can be used only with True Color and Grayscale output types. PNG.
A compressed image file format that might replace GIF. Like GIF, PNG uses non-lossy compression, which means all the visual data is saved and restored
when the file is decompressed. Unlike GIF, PNG can be used with True Color and Grayscale output types. PICT. Apple's proprietary image file format that is
used by the Macintosh operating system. Designed for the screen, this format is best used for color images that will not be printed. Images saved as PICT files
are smaller in size than images saved as a TIFF files. PDF. PDF is a format useful for text, photos, and drawings. Use Adobe Acrobat® Reader to view PDF
files.
If no changes need to be made to the file, this file type is useful for sharing (as through email) and filing because of its generally small file size. When using
the Macintosh version of the scanning software, you can only create image-only PDF files; you cannot copy text from these files. q To save to a file 1 Do one
of the following: q q On the Scan menu, click Save As. On the toolbar, click . 2 3 4 Select a file type.
See "List of file types" on page 52. Select a name and location for the file and click OK. If the Options button is available, more options are available for this
file type. Click Options, change any options you want, and click OK. q The file type you need depends on how you will use the file.
And, some file types are not available when certain output types are selected. To save a scan for future processing in OCR software If you plan to process a
scanned document with your optical character recognition (OCR) software, use the following settings: q q q q Resolution: 300 Output type: Black & White
Bitmap Format: TIFF Note: Selecting higher resolutions than 300 dpi will not increase OCR accuracy. q Back to TOC q Scanning from HP PrecisionScan
Pro 53 TIFF. Usually created by scanners, TIFF files are widely accepted by programs that work with photographs and other images. A TIFF file is a
bitmapped graphic (also called a raster graphic) and can be any resolution. TIFF image files can be used on multiple platforms. TIFF compressed.
Compressed TIFF files for images are smaller than standard TIFF files. q Text or text-and-image file formats q HTML. HTML is useful for text and graphics
that will be viewed on the World Wide Web.
When this format is selected for a scanned image containing both text and images, the text is converted to editable text and is saved as HTML, and the
graphics are saved as GIF or JPEG files. Rich Text. The RTF format can be used with a page that contains text or text and pictures. The formatting of text in
an RTF file can usually be retained and then interpreted by other programs. Text. Use text file format for saving only the text in the selection area. Text will
be editable, unformatted, ASCII text. q q 54 Scanning from HP PrecisionScan Pro Back to TOC Printing The selection area is the part of the image that
prints. If there is no selection border, the contents of the entire scanner bed, including blank areas, print. Printing does not save the image to the computer.
Save the scanned image to a file to use the image later. To print 1 Do one of the following: q q On the Scan menu, click Print. On the toolbar, click . 2 In the
Print dialog box, select the options you want and click OK. Back to TOC Scanning from HP PrecisionScan Pro q 55 Placing a scan on a website There are
many website development tools, or HTML editors, available.
These applications help you develop websites, and support a variety of graphics file formats. However, not all Web browsers can display all the file formats
that Web development applications support. Copy and paste the image You can use the scanning software's Copy menu command or icon to copy the image to
the Clipboard. In the Web page development application, use the Paste menu command to paste the image in the Web page document. q With the HP scanning
software, you can scan your text or images, make adjustments to these scans, and then prepare them for the World Wide Web.
Use the Scan To menu command You can use the scanning software's Scan To menu command in the Scan menu to scan the image to text file. Then, in the
Save dialog box, select HTML in the Format pop-up box. To scan an item for a website To scan an item for website, use one of the following methods: q
Optimizing a scan for online viewing To optimize a scan for a Web page, be sure to do the following: q Drag-and-drop from the scanning software If your
Web page development application supports drag-and-drop, you can drag the image from the Preview area of the scanning software and drop it into the open
page where you want it. Some Web page applications have image editing capabilities if you want to adjust the image further. You should consult the
documentation that came with the Web page development application for more information. Save scans as GIF, JPEG, or PNG files.
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